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GUIDED TOUR

Welcome to AutoCAD 2004 Instructor.  Here are some features you will find in this book to help you
learn AutoCAD 2004.

Chapter Objectives

Each chapter opens with a list of new
concepts you can expect to learn.
Having objectives in mind helps you
focus on the important ideas as you
move through each chapter.

Practice Tables

Step-by-step practice exercises in the
early chapters help you systematically
tackle fundamental skills.

MODIFY
COMMANDS I

Chapter Objectives

After completing this chapter you should:

1. be able to Erase objects;

2. be able to Move objects from a base
point to a second point;

3. know how to Rotate objects about a
base point;

4. be able to enlarge or reduce objects
with Scale;

5. be able to Stretch objects and
change the length of Lines and Arcs
with Lengthen;

6. be able to Trim away parts of objects
at cutting edges and Extend objects
to boundary edges;

7. know how to use the four Break
options;

8. be able to Copy objects and make
Mirror images of selected objects;

9. know how to create parallel copies
of objects with Offset;

10. be able to make rectangular and
polar Arrays of objects;

11. be able to create a Fillet and a
Chamfer between two objects.

STEPS COMMAND PROMPT PERFORM ACTION COMMENTS

1. Command: type M and press Spacebar M is the command alias
for Move

2. MOVE Select objects: use pickbox to select one objects are highlighted
Line and the Circle

3. Select objects: press Spacebar or Enter

4. Specify base point or PICK near the Circle center base point is the handle,
displacement: or where to move from

5. Specify second point of PICK near the other Line second point is where to
displacement: move to

STEPS COMMAND PROMPT PERFORM ACTION COMMENTS

1. Command: select the Modify pull-down,
then Move

2. MOVE Select objects: type W and press Spacebar select only the circle;
object is highlighted

3. Select objects: press Spacebar or Enter

4. Specify base point or PICK near the Circle center base point is the handle,
displacement: or where to move from

5. Specify second point of PICK near the original second point is where to
displacement: location move to

Using Move
The Move command specifically prompts you to (1) select objects, (2) specify a “base point,” a point to
move from, and (3) specify a “second point of displacement,” a point to move to.

78 Selection Sets

MOVE COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Modify (Edit Mode) MODIFY2
Move MOVE M Move Move V,19

1. Draw a Circle and two Lines.  Use the Move command to practice selecting objects and to move
one Line and the Circle as indicated in the following table.

2. Use Move again to move the Circle back to its original position.  Select the Circle with the 
Window option.
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Command Tables

Whenever an AutoCAD command 
is introduced in the book, this table
indicates all the methods you can 
use to call up the command.

“2004“ and “2002” Bars 

These vertical bars in the page margins
allow you to quickly identify the com-
mands and options that are new in
AutoCAD 2004 and in AutoCAD 2002.
This feature is especially helpful for
readers updating from either AutoCAD
2002 or 2000.

168 Modify Commands I

Objects can be made longer or shorter
with Stretch. The power of this command
lies in the ability to Stretch groups of
objects while retaining the connectivity
of the group (Fig. 9-9). When Stretched,
Lines and Plines become longer or shorter
and Arcs change radius to become longer
or shorter. Circles do not stretch; rather,
they move if the center is selected within
the Crossing Window.

Objects to Stretch are not selected by the
typical object selection methods but are
indicated by a Crossing Window or 
Crossing Polygon only.  The Crossing
Window or Polygon should be created so
the objects to Stretch cross through the
window.  Stretch actually moves the
object endpoints that are located within
the Crossing Window.

Following is the command sequence for Stretch.

Command: stretch
Select objects to stretch by crossing-window or crossing-polygon...
Select objects:  PICK
Specify opposite corner:  PICK
Select objects:  Enter
Specify base point or displacement:  PICK or (coordinates)  (Select a point to stretch from.)
Specify second point of displacement: PICK or (coordinates)  (Select a point to stretch to.)
Command:

Stretch can be used to lengthen one object
while shortening another.  Application of
this ability would be repositioning a door
or window on a wall (Fig. 9-10).

In summary, the Stretch command stretches
objects that cross the selection Window and
moves objects that are completely within
the selection Window, as shown in 
Figure 9-10.

Figure 9-10

STRETCH COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

Modify MODIFY2
Stretch STRETCH S … Stretch V,22

Figure 9-9

914 3D Display and Viewing

Next, if you desire all views to
display the object proportionally,
use Zoom with a constant scale factor
(such as 1, not 1x) in each viewport.
This action would generate a display
similar to that shown in Figure 35-38.

This 3D Setup option is available only
from the Viewports dialog box.  If you
use one of the other options from the
View pull-down menu (3 Viewports, 4
Viewports, etc.) or type the command
line version (-Vports), you cannot
automatically generate a typical
orthographic view setup.

NOTE:  The setting of UCSORTHO
has an effect on the resulting UCSs
when the 3D Setup option of the
Viewport dialog box is used.  If
UCSORTHO is set to 0, no new UCSs
are created when Vports is used.  However, if UCSORTHO is set to 1, a new UCS is generated for each
new orthographic view created so that the XY plane of each new UCS is parallel with the view.  In other
words, each orthographic view (not the isometric) now shows a UCS with the XY plane parallel to the
screen.  See Chapter 36 for more information on the UCSORTHO system variable.

Printing Shaded 3D Models

In AutoCAD 2004 you can print 3D models in shaded mode.  If you have a
laserjet, inkjet, or electrostatic type printer configured as the plot device
(not a pen plotter), you can select from As Displayed, Wireframe, Hidden, or
Rendered options from the Plot dialog box or from the Properties palette for
the viewport.

Printing a Shaded Image From the Model Tab
If you want to print a shaded 3D drawing from the Model tab, use the
Shaded Viewport Options section of the Plot dialog box, Plot Settings tab.  Use
the Shade Plot drop-down list to produce the desired Wireframe, Hidden, or
Rendered display in the print (Fig. 35-43).  Alternately, you can use the
Shademode or Render commands to produce the desired display on screen,
then select As Displayed from this list to print the drawing as it appears on
screen.  You can also select from several resolution qualities for the print
(see the “Shaded Viewport Options” section in Chapter 14).

Printing a Shaded Image From a Layout Tab
If you are printing from a layout and want to specify a shaded image for
one or more viewports, use the Shadeplot option of the viewport’s Properties
palette.  Here you can select from the same options (Fig. 35-44) as in the
Plot dialog box.

Figure 35-42

Figure 35-43

Figure 35-44
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“TIP!” Icons

“TIP!” icons point out time-saving tricks
and tips that otherwise might be discovered
only after much experience with AutoCAD.

Graphically Driven Page Layout

Over 1500 illustrations are given in 
the book.  Explanatory text is located
directly next to the related figure.

342 Draw Commands II

Editing Multilines

Because a multiline is treated as one object and its complex configuration is defined by the multiline
style, traditional editing commands such as Trim and Extend, cannot be used for typical editing func-
tions.  Instead, a special set of editing functions are designed for Mlines.  The Mledit (multiline edit)
command provides the editing functions for existing multilines and is discussed in Chapter 16.  Your use
for Mlines is limited until you can edit them with Mledit.

SKETCH COMMAND ALIAS Short- Screen (side) Tablet
Pull-down Menu (TYPE) (TYPE) cut Menu Menu

… SKETCH … … … …

The Sketch command is unlike other draw
commands.  Sketch quickly creates many
short line segments (individual objects) by
following the motions of the cursor.  Sketch is
used to give the appearance of a freehand
“sketched” line, as used in Figure 15-32 for
the tree and bushes.  You do not specify indi-
vidual endpoints, but rather draw a freehand
line by placing the pen down, moving the
cursor, and then picking up the pen.  This
action creates a large number of short Line
segments.  Sketch line segments are tempo-
rary (displayed in a different color) until
Recorded or until eXiting Sketch.

CAUTION:  Sketch can increase the drawing file size greatly due to the relatively large number of line
segment endpoints required to define the Sketch line.

Command: sketch

Record increment <0.1000>: (value) or Enter (Enter a value to specify the segment increment
length or press Enter to accept the default increment.)
Sketch. Pen eXit Quit Record Erase Connect. (letter) (Enter “p”  or press button #1 to put the pen
down and begin drawing or enter another letter for another option.  After drawing a sketch line,
enter “p” or press button #1 again to pick up the pen.)

It is important to specify an increment length for the
short line segments that are created.  This 
increment controls the “resolution” of the Sketch
line (Fig. 15-33).

Too large of an increment makes the straight line seg-
ments apparent, while too small of an increment unnec-
essarily increases file size.  The default increment is 0.1
(appropriate for default Limits of 12 x 9) and should be
changed proportionally with a change in Limits.
Generally, multiply the default increment of 0.1 times the
drawing scale factor.

Figure 15-33

Figure 15-32

Overlay
An Xref Overlay is similar to an
Attached Xref with one main dif-
ference—an Overlay cannot be
nested. In other words, if you
Attach a drawing that (itself) has
an Overlay, the Overlay does not
appear in your drawing. On the
other hand, if the first drawing
is Attached, it appears when the
parent drawing is Attached to
another drawing
(Fig. 30-18).

746 Xreferences

Figure 30-18

Figure 30-20

To produce an Overlay using the Xref Manager, you
must first select the Attach button to produce the
Select File dialog box.  After selecting the desired
file to overlay, press the Overlay button in the
External Reference dialog box that appears 
(Fig. 30-19).  If you type the –Xref command,
simply use the Overlay option and the standard
Select File dialog box appears.

Figure 30-19

The Overlay option prevents “circular” Xrefs
from appearing by preventing unwanted
nested Xrefs.  This is helpful in a networking
environment where many drawings Xref
other drawings.  For example, assume
drawing B has drawing A as an Overlay.  As
you work on drawing C, you Xref and view
only drawing B without drawing B’s over-
lays—namely drawing A.  This occurs
because drawing A is an Overlay to B, not
Attached.  If all drawings are Overlays, no
nesting occurs (Fig. 30-20).
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Chapter Exercises

Exercises help you try out the commands
discussed in each chapter.  Exercises
begin with simple, step-by-step use of
commands and progress to more
advanced drawings based on synthesis
of earlier ideas.

Reference Material

Useful for self study or classroom use,
tabbed pages help you quickly locate
the Command Table Index, Shortcut
Keys, Dimension Variables, System
Variables, Tables of Limits Settings,
Template Drawings and more.

Supplements at www.mhhe.com/leach

An online learning center provides additional material for students and instructors.
Students can download 25 test or review questions for each chapter, discipline-specific
exercises for each chapter (architectural, mechanical and civil/electrical), and even 3 addi-
tional advanced chapters.  Solutions for the chapter exercises (.DWG files) and review ques-
tions (Word format) are available for instructors.

Chapter Twenty-Four 581

CHAPTER EXERCISES

1. Open the PIVOTARM CH16 drawing.

A. Create the right side view.  Use OSNAP and
ORTHO or Polar Tracking to create Lines or
Rays to the miter line and down to the right
side view as shown in Figure 24-34.  Offset
may be used effectively for this purpose
instead.  Use Extend, Offset, or Ray to
create the projection lines from the front
view to the right side view.  Use Object Snap
Tracking when appropriate.

B. Trim or Erase the unwanted projection
lines, as shown in Figure 24-35.  Draw a
Line or Ray from the Endpoint of the diago-
nal Line in the top view down to the front to
supply the boundary edge for Trimming the
horizontal Line in the front view as shown.

Figure 24-34

Figure 24-36

Figure 24-35

C. Next, create the hidden lines for the
holes by the same fashion as before.  Use
previously created Layers to achieve the
desired Linetypes.  Complete the side
view by adding the horizontal hidden
Line in the center of the view.

1260 Command Table Index

Screen Chapter
Command Name Pull-down ALIAS Short (side) Tablet in this
(type) Button Menu (type) Cut Menu Menu Text

HELP Help HELP
Help ? F1 Help Y,7 5

HIDE View VIEW 2
Hide HI … Hide M,2 35

HLSETTINGS … … … … … 35

HYPERLINK Insert
Hyperlink… … Ctrl+K … … 19

HYPERLINKBASE … … … … … 19

ID Tools
Inquiry > TOOLS 1
ID Point … … ID U,9 17

IMAGE Insert INSERT
-IMAGE Image Manager... IM, -IM … Image T,3 32

IMAGEADJUST Modify
Object> 
Image> MODIFY1
Adjust… IAD … Imageadj X,20 32

IMAGEATTACH Insert INSERT
Image Manager… Image
Attach… IAT … Attach... … 32

IMAGECLIP Modify 
Clip> MODIFY1
Image ICL … Imageclp X,22 32

IMAGEFRAME Modify 
Object>
Image> MODIFY1
Frame … … Imagefrm … 32

IMAGEQUALITY Modify
Object> 
Image> MODIFY1
Quality … … Imagequa … 32

IMPORT … IMP … … T,2 32

INDEXCTL File
Saveas… FILE
Tools Saveas…

Options… Options…
Index type … … Index type … 30

INETLOCATION Tools TOOLS2
Options Options
Files Files
Menu, Help, and Menu, Help, and

Misc. File Names Misc. File Names
Default internet Default internet 

Location … … Location … 19 

INSERT Insert INSERT
-INSERT Block… I, -I … Ddinsert T,5 21

INSERTOBJ Insert INSERT
OLE Object… IO … Insertob T,1 31

INTERFERE Draw DRAW 2
Solids > SOLIDS
Interference INF … Interfer … 39
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